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MagBytes; the fine print 
This is a free New Zealand subscriber email info magazine from the NZ Apple news and info site mac-nz.com.
MagBytes tells you what’s happening and what’s new in the world of Apple every month, compiled from Mac NZ. 
Learn tips and how to do interesting things with your Macs and iDevices, and how to get more out of them. 
MagBytes is brought to you by Mark Webster, onetime editor of NZ Macguide magazine and a long-time trainer and commentator on Apple and the world of technology. 
Mark wrote about Apple for a worldwide audience on the New Zealand Herald under the title ‘Apple Watch’ (2009-2014) and at his Mac NZ Apple info site for New Zealand. You can store 
your issues of MagBytes on your HD, Thumb Drive or on CD/DVD, read it on screen, or even just drag it to iTunes (or to iBooks, from macOS 10 Mavericks onwards, which means you end up 
with a reference library you can search, highlight, add notes to etc) and have it appear on your iPhone and iPad (inside iBooks) next time you sync. Or print it out, even – and please feel free 
to pass MagBytes on. MagBytes is free to receive; recipients details are not shared with, or available to, anybody except me.  
Find out more about the MagBytes Apple newsletter online (click on ‘MagBytes Newsletter’ at top right).

July 2017  
•2——Mac News ~ Apple people, 
spotting Phishing, loads of  money, 

Jobs’ opera (!), selling your 
Mac, Machine Learning, biggest 

turbines, 100 best games 
•4——Updates ~ Security 

Updates, Logic Pro, Fantastical, 
iTunes, Panic, 5k Wallpapers, Intel 

•6——Mac Help ~  
Around New Zealand 

•7—— iOS & iDevice news ~ iOS 
11 features, document scanning, 

execs to Oz, Disney Clips,  
iPhone use, Nokia Health,  

NZ password app 
•9——Apple & Talk ~ Good 

enemies and Succession;  
ten years of  iPhones 

•11——Tips & Tricks ~ Weather 
anywhere, Reminders, Night Shift, 
Calendar, Live Photos, Messages, 
iPhone force-quitting and a whole 

lot more – even an AI ode to Queen 
•17——How To ~ Get the  

most from Mac NZ

Monthly NZ newsletter of  things Apple for your edification and delectationMagBytes

My ‘old’ iPhone 6 still has a terrific camera, even in low light, as this Night Lights picture from the Auckland Museum of Transport 
and Technology shows (projection work by Creature). So what will ‘iPhone 8’ bring us?

mailto:mac.nz%40me.com?subject=From%20MagBytes
mailto:mac.nz%40me.com?subject=From%20MagBytes
http://www.creativetech.net.nz
http://www.mac-nz.com
http://www.mac-nz.com
http://www.mac-nz.com
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Mac News > People person, spotting Phishing, Apple tops profitability

New People person
Apple has announced that Deirdre 
O’Brien, vice president of Worldwide Sales 
and Operations, has been named head of 
human resources —a title the company is 
calling ‘Vice President of People.’ O’Brien 
has now worked for five Apple CEOs.

Tips for spotting Phishing email
84% of NordVPN’s National Privacy Test 
respondents said they would ignore an 

More news is online at Mac NZ

email request from a bank asking for 
personal information. 
Yet statistics show that up to 45% of 
Internet users keep clicking on dangerous 
links or providing personal information 
where they shouldn’t. 
Here are some tips for spotting this 
insidious form of malware that Macs are 
still prone to .... because Mac users are 
humans.

Loadsa money
Apple once again has claimed the top spot 
in global profits, according to Fortune’s 
annual ranking of US companies shaping 
the world. In Fortune magazine’s 63rd 
composition of the list of Fortune 500 
companies, Apple has seized the third 
spot in revenue, behind only Walmart and 
Berkshire Hathaway. 
However, ranked by profitability, Apple 
destroys all challengers, reaping $45.7 

mailto:mac.nz%40me.com?subject=From%20MagBytes
mailto:mac.nz%40me.com?subject=From%20MagBytes
http://appleinsider.com/articles/17/07/21/deirdre-obrien-named-as-apples-new-vice-president-of-people-overseeing-hr
http://appleinsider.com/articles/17/07/21/deirdre-obrien-named-as-apples-new-vice-president-of-people-overseeing-hr
https://www.macobserver.com/news/deirdre-o-brien-apple-hr-head-worked-5-apple-ceos
http://www.mac-nz.com
http://www.istorenz.com
https://www.appleworld.today/blog/2017/7/22/some-tips-for-spotting-a-phishing-email
https://www.appleworld.today/blog/2017/7/22/some-tips-for-spotting-a-phishing-email
http://appleinsider.com/articles/17/07/20/apple-ranked-as-most-profitable-us-company-by-far-on-newest-fortune-500-ranking
http://appleinsider.com/articles/17/07/20/apple-ranked-as-most-profitable-us-company-by-far-on-newest-fortune-500-ranking
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Mac News > Opera, biggest turbines, China, Machine Learning no trouble, games

billion in profit and handily 
dispatching second place JP 
Morgan Chase with $24.7 billion. 
[Is that where cutting the affiliate 
payouts got Apple? Yeah, I hardly 
think so.]

Steve Jobs opera
Almost two years after the 
Santa Fe Opera commissioned 
The (R)evolution of Steve Jobs, the 
narrative, music and rehearsals 
are complete and the production 
has opened as part of a limited 
six-show run. [Sorry, the only Apple rhyme 
that springs to mind in all this is ‘crapple’.]

Your Mac and selling it
Planning to sell your Mac? AppleInsider 
covers the step-by-step process of backing 
up your files, wiping the hard drive and 
restoring everything on a new machine in 
this video. [This is important as software 
that can get ‘deleted’ files from Macs is 
widely available.]

Biggest Oregon turbines
Regulators have cleared Apple’s Oregon 
wind power project to use the biggest 
turbines ever deployed in the Pacific 
Northwest, reports the Portland Business 
Journal.

Managing director of  China
Apple has named vice president of wireless 
technologies Isabel Ge Mahe as managing 
director of Greater China, where she will 
report to CEO Tim Cook and COO Jeff 
Williams. Under the newly created role, 
Apple said in a prepared statement that 
Mahe will lead and coordinate Apple’s 
team in China. 
Mahe was born in Shenyang, Liaoning, 
so is fluent in Mandarin. She earned 
both Bachelor and Master of Electrical 
Engineering degrees from Simon Fraser 
University in British Columbia and also 
holds an MBA from the University of 
California (Berkeley), where she also 
serves as an industry advisor to the 
school’s EE/CS department.

More news is online at Mac NZ

Apple & Machine 
Learning
Apple has launched a new 
machine learning sub-site 
written by Apple engineers 
discussing techniques in use 
for better results and to assist 
burgeoning developers in the 
field.

Macs almost trouble-free
Here’s another good reason 
to keep using Mac, or switch if 
you’re not currently a Mac user: 

macOS and macOS apps only account for 
0.3% of computer repair issues in 2017, as 
compiled by the RESCUECOM computer 
repair company.
“Windows apps are the biggest problem 
this year due to buggy Windows 10 
updates,” says RESCUECOM. “While 
Microsoft fixes the errors, they still cause 
problems and frustration.”

The 100 Best Mac Games
MacGamer HQ has released its list of The 
100 Best Mac Games, providing a summary 
of the games, system requirements, 
pricing and more. Nowadays, seven out of 
the 10 most-played games on Steam have 
a Mac version and all the best indie game 
developers support Mac too.

mailto:mac.nz%40me.com?subject=From%20MagBytes
mailto:mac.nz%40me.com?subject=From%20MagBytes
http://appleinsider.com/articles/17/07/19/steve-jobs-opera-set-to-premier-this-week-after-two-years-of-preparation
http://appleinsider.com/articles/17/07/19/steve-jobs-opera-set-to-premier-this-week-after-two-years-of-preparation
http://appleinsider.com/articles/17/07/17/how-to-backup-wipe-and-restore-your-mac-before-selling-it
https://www.appleworld.today/blog/2017/7/20/apples-oregon-wind-power-project-to-use-the-biggest-turbines-ever-deployed-in-the-area
https://www.appleworld.today/blog/2017/7/20/apples-oregon-wind-power-project-to-use-the-biggest-turbines-ever-deployed-in-the-area
http://appleinsider.com/articles/17/07/18/apple-appoints-isabel-ge-mahe-as-managing-director-of-greater-china
http://appleinsider.com/articles/17/07/18/apple-appoints-isabel-ge-mahe-as-managing-director-of-greater-china
http://www.mac-nz.com
http://appleinsider.com/articles/17/07/19/apple-allows-publicity-transparency-for-in-house-researchers-with-new-machine-learning-journal
http://appleinsider.com/articles/17/07/19/apple-allows-publicity-transparency-for-in-house-researchers-with-new-machine-learning-journal
https://www.appleworld.today/blog/2017/7/18/macos-mac-apps-only-account-for-03-of-common-computer-repair-issues-in-2017
https://www.appleworld.today/blog/2017/7/13/macgamer-hq-announces-its-the-100-best-mac-games-today-list
https://www.appleworld.today/blog/2017/7/13/macgamer-hq-announces-its-the-100-best-mac-games-today-list


‘MagBytes’, 
‘Mac NZ’, this 
document & all 
Intellectual  
Property 
Rights are all 
owned by Hip  
Enterprises/
Mark  
Webster 2017. 
Copyright 
Mark  
Webster/ 
Mac NZ/ 
Hip 
Enterprises 
2010-2017.  
No reprinting 
or republish-
ing without 
permission. 
For  
permission, 
please   
email 
Mac NZ 

Mac NZ

>>

>
>

page 

4
MagBytes

#89

Security Updates for OS X Yosemite, El Capitan
Apple has released security updates for OS X Yosemite and OS 
X El Capitan. Apple’s patch notes for both updates specify only 
that, “Security Update 2017-003 is recommended for all users and 
improves the security of OS X.”

Logic Pro X gets more Drummer options,
Apple has updated Logic Pro X, its digital audio workstation, with 
a group of new features as well as various bug fixes. The upgraded 
software includes extra Pop, Songwriter and Latin Drummers, 
according to Apple. New Drummer loops can be added to a song 
and tweaked using performance controls. The free update is 
available via the Mac App Store.

Fantastical 2.4 for Mac
Fantastical 2.4 for Mac adds key new features, and AppleInsider 
has checked to see if the NZ$74.99/US$50 entry price is worth it. 
(If you’ve already a user then this update to Fantastical for the 
Mac is free.) Apple Insider finds that the new Fantastical 2.4 for 
Mac brings features that may clinch the deal for you.

iTunes 12.6.2 for Mac maintenance release
Apple has released iTunes 12.6.2. It’s a maintenance release, with 
Apple’s patch notes saying only, “This update includes minor app 
and performance improvements.”

Panic Transmit 5 File Transfer Utility for Mac
Panic announced the release of Transmit 5, seven years after the 
release of version 4 of its popular file transfer app. New features 
include support for Panic Sync and 10 cloud services.

Updates > Security updates, Logic, Fantastical, Panic, Intel, repairing your HD

Every default 
macOS Desktop 
wallpaper in 5K 
The default Desktop 
image, or wallpaper, 
has changed with every 
macOS major update. 
Mac OS X 10, as it was 
known back in the day, 
included a blue Desktop 
background with sweeping arcs (pictured: does that make you 
nostalgic?). In 10.5 that became an aurora space cloud sort of 
thing, and in macOS 10.10 we started seeing mountains.
Those images are cool, and now you can use them as your 
desktop wallpaper in 5K resolution thanks to Stephen Hackett at 
512 Pixels. He has all of Apple’s default Mac desktop pictures at 
high resolution ready to download and they all look great. [If your 
monitor is not a Retina display, seriously, don’t do this! It will just tax 
lesser displays.] 

Purley gates
Intel has taken the wraps off of its Purley series of Xeon 
processors, and it appears there are a few candidates for possible 
processors that could be included in Apple’s iMac Pro, slated to 
launch this December.

Repair a disk using macOS Sierra’s Disk Utility
You can use the Apple Disk Utility app in macOS Sierra [and in 
previous versions of macOS] to repair a variety of problems. 
Here’s how to repair the disk that starts up your Mac.

mailto:mac.nz%40me.com?subject=From%20MagBytes
mailto:mac.nz%40me.com?subject=From%20MagBytes
https://www.macobserver.com/news/product-news/apple-releases-security-updates-os-x-yosemite-el-capitan/
https://www.macobserver.com/news/product-news/apple-releases-security-updates-os-x-yosemite-el-capitan/
https://itunes.apple.com/app/fantastical-2-calendar-and-reminders/id975937182
https://itunes.apple.com/app/fantastical-2-calendar-and-reminders/id975937182
http://appleinsider.com/articles/17/07/22/hands-on-fantastical-24-for-mac-adds-attachments-facebook-calendar-integration
https://www.macobserver.com/news/product-news/panic-releases-transmit-5-file-transfer-utility-mac-supports-panic-sync-cloud-services/
https://512pixels.net/projects/default-mac-wallpapers-in-5k/
https://512pixels.net/projects/default-mac-wallpapers-in-5k/
http://appleinsider.com/articles/17/07/11/intel-announces-purley-xeon-processors-possibly-destined-for-apples-imac-pro
http://appleinsider.com/articles/17/07/11/intel-announces-purley-xeon-processors-possibly-destined-for-apples-imac-pro
https://www.appleworld.today/blog/2017/7/12/how-to-repair-a-disk-using-macos-sierras-disk-utility
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USB-C to USB Cable
Power and charge any USB-C device (ie, MacBook, late 2016 
MacBook Pro) using a regular USB charger. Supports USB 3.1 
Gen 1 data transfer speeds of up to 5 Gbps, Moshi’s USB-C 
to USB Cable is encased in aluminium with reinforced stress 
relief points and includes a HandyStrap cable manager
NZ RRP$44.99

IonGlass for 
iPhone 7
IonGlass is an atomically-
strengthened glass screen 
protector featuring 
smooth, edge-to-edge 
protection with a micro-
bevel around the Home 
button for fast unlocking 
via Touch ID. Its exceptional 
hardness exceeds that of 
steel. 
NZ RRP$59.99 
(iPhone 7 Plus, NZ$69.99)

USB-C to VGA adapter
Output HD video from any USB-C device or laptop 
to a VGA display or projector. Moshi’s VGA adapter 
supports video resolution up to 1920 x 1200/1080p 
at 60Hz. Both ends of the cable are encased in 
anodised aluminium to minimise electromagnetic 
interference. With its reversible USB-C connector 
and plug-n-play capability, the adapter guarantees a 
hassle-free setup for convenient home or office use
NZ RRP$69.99

USB-C Charge Cable
Smart LED indicators keep track of your charging 
status. Supporting up to 60 Watts of power output 
and USB 2 data transfer speeds, Moshi’s USB-C 
Charge Cable has durable aluminium housings and 
delivers utility and style for anyone with an Apple 
Retina MacBook, Google Chromebook Pixel, or 
any mobile device equipped with a USB-C port. At 
2 metres length (6.6 feet) in length, a HandyStrap 
is also included to keep your cable neat and tidy 
during transport 
NZ RRP$59.99

armour for  
iPhone 6-7
The armour features a 
diamond-cut aluminium 
backplate with a unique 
metallic finish, the 
hybrid material has 
shock absorption and is 
scratch resistant. It has 
fully-encased volume and 
power buttons and the 
raised bezel protects the 
display and the case offers 
military-grade drop-
protection (MIL-STD-810G, 
SGS-certified)
NZ RRP$64.99

mailto:mac.nz%40me.com?subject=From%20MagBytes
mailto:mac.nz%40me.com?subject=From%20MagBytes
https://www.macgear.co.nz/collections/moshi/products/moshi-usb-c-to-usb-cable-1m
https://www.macgear.co.nz/collections/moshi/products/moshi-usb-c-to-usb-cable-1m
https://www.macgear.co.nz/collections/moshi/products/moshi-ion-glass-for-iphone-7-plus
https://www.macgear.co.nz/collections/moshi/products/moshi-usb-c-to-vga-adaptor
https://www.macgear.co.nz/collections/moshi/products/moshi-usb-c-charge-cable-2m-1
https://www.macgear.co.nz/collections/moshi/products/moshi-usb-c-charge-cable-2m-1
https://www.macgear.co.nz/collections/moshi/products/moshi-iglaze-armour-for-iphone-7
http://www.macgear.co.nz
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Apple support & AppleCare
Apple’s official support pages are 
comprehensive and cover all aspects of 
Apple hardware and software – it’s here.
Also try Intro to the Mac and How Tos.
AppleCare: If you need your Mac fixed, 
look for an Apple licenced repair centre. 
People often ask me if they should buy 
AppleCare with their devices. Every new 
Mac has a one-year warranty and 90 days 
free phone support. AppleCare extends 
this all out to three years. Under NZ 
law, you are covered by the Consumer 
Guarantees Act against anything going 
wrong that comes down to parts failure 
within reasonable expectations (say, inside 
three years’ use), but be prepared to spend 
anxious time on the phone, sticking to 
your guns to get it fixed. 
However, this absolutely does pay off.
AppleCare is expensive, depending on the 
device, but it’s a replacement policy which 
covers you anywhere in the world. 
If you travel and you want full reassurance, 
and you can afford it, AppleCare is superb.

Mac Senior Net — ready to help
If you are aged 55 years or better and you 
use an Apple computer or device, Mac 
Senior Net is a wonderful resource.

Christchurch: With nearly 600 
members, this very active Apple-
focussed group covers Christchurch with 
a dedicated lab – and caters to the city’s 
surrounds by running iPad sessions in 
rest homes. This is a large, well-run and 
successful group.
 
Auckland: Mac Senior Net Auckland 
provides on-going Apple Mac and iDevice 
knowledge to help competency, learnt 
alongside others in similar situations. 
The Auckland Club holds monthly 
meetings in Howick, Bayswater and 
Remuera and provides lessons and talks 
very reasonably. Go to MSN Ak’s web page 
or email Marion Moffat.
Handy Absolute Beginners’ courses are also 
available at SeniorNet, including for iPads.
Eden Roskill — This Auckland branch has 
an Apple Group that meets on the second 
Monday of every month at 487 Dominion 
Rd in the Mt Eden Senior Citizen Rooms, 
opposite Potter’s Park in Balmoral. There 
are several courses for Apple users (Mac, 
iPhone and iPad) as numbers warrant. To 
join, call Janet 09 828 3098

Mac diagnostics
Your Mac has various diagnostic tools and 
routines available. If you think things are 
going awry, check the Help page on Mac 
NZ (click on Help at the top), but the first 
thing you can do is open the Utilities folder 
on your Mac’s applications folder, and find 
Apple’s Disk Utility (that’s its icon, above). 
Launch it, select your Mac’s internal hard 
drive which is normally called ‘Mac HD’ (or 
plugged in hard drive/flash drive/camera 
card etc) and run First Aid over it. (iDevices 
are another story!)

Mac help in the North 
Dave Boswell has been a reseller in 
Whangarei for 20 years and can assist. 
Contact MacNorth Computers 09 433 
9855, 027 490 2332, or email Dave 
Boswell.

Mac Help > Apple diagnostics, Consumer Guarantees Act, help, support

Papakura — Mac Interest Group meets 
every 1st, 3rd and 4th week of the month 
9.30 to Noon. An iPad Interest Group 
meets every 3rd Tuesday at 1pm
An “Introduction to iPad” course run on 
demand.

mailto:mac.nz%40me.com?subject=From%20MagBytes
mailto:mac.nz%40me.com?subject=From%20MagBytes
http://www.apple.com/support/
http://www.apple.com/nz/findouthow/mac/
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http://www.consumeraffairs.govt.nz/for-consumers/law/consumer-guarantees-act
http://www.consumeraffairs.govt.nz/for-consumers/law/consumer-guarantees-act
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http://www.seniormac.org.nz
http://www.seniormac.org.nz
http://www.macsnrs.org.nz
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http://www.seniornet-eden-roskill.org.nz
http://www.mac-nz.com/help_.html
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iDevice news

Logitech ad

Hands on with iOS 11
With the newly revamped iPad app 
dock in iOS 11, Apple introduces 
a completely new interaction 
experience more in line with 
macOS. 
Check out the new UI, which 
supports in-the-dock app 
interactions and drag-and-drop 
gestures, in this AppleInsider video.
Apple is also completely revamping 
the App Store in iOS 11, adding 
a number of new features and 
under-the-hood enhancements, 
while at the same time streamlining 
the platform’s user interface. 
AppleInsider goes over all the 
changes in this in-depth video.
Other changes include Apple’s 
Augmented Reality Maps.
Wondering how Apple’s new Files 
app for iOS 11 works on iPad? 
AppleInsider takes an in-depth look 
at the upcoming file management 
system in this video.

iPhone document scanner
Nothing can beat having the 
iPhone’s camera with you always, 
but many, many tools can better 
how that camera shoots documents 
and what you can do with them 

> iOS 11 features, scanning docs with iPhones

More news is online at Mac NZ

mailto:mac.nz%40me.com?subject=From%20MagBytes
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iDevice news> Aussie encryption, Disney, iPhone use, Nokia, NZ passwords

later. AppleInsider staffers show you 
what apps and hardware they use to scan 
everything from single receipts to the 
contents of a history archive.

Apple execs to Australia
Apple has sent top privacy executives to 
Australia twice over the past month to 
discuss proposed cybersecurity laws that 
could compel technology companies to 
provide law enforcement agencies access 
to encrypted customer messages. [Pass out 
a few iPhones and Bob’s yer uncle?]

Clips gets Disney characters 
Apple has updated Clips, its app that 
allows iPhone and iPad users to create 
‘expressive videos.’ It lets you combine 
video clips, photos and music into 
videos to share with friends through the 
Messages app, or on Instagram, Facebook 
and other social networks.
The update includes dozens of new graphic 
overlays and posters, plus usability 
improvements. Users can now add classic 
Disney and Pixar characters to their videos.

iPhones still being used
Nearly two-thirds of iPhones sold since the 
2007 launch remain in use, according to 
data from Newzoo (as cited by Digitimes). 
The market intelligence firm says that 728 

million Apple smartphones remained in 
use as of April, which represents about 
63% of all iPhones sold in the past decade.

Apple & Nokia Health
Back in April of 2016, Nokia bought 
connected-body accessory manufacturer 
Withings, a company that makes the Body 
Cardio and Body+ smart scales, Thermo 
Thermometer, and BPM+ Blood Pressure 
Monitor. Due to a patent battle with Nokia 
over intellectual property licensing, Apple 
pulled the products from sale at Apple 
retail and online stores.
The two companies settled their 
differences in May of 2017, with Apple 
agreeing to a multi-year license to the 
patents in question and also agreeing to 

More news is online at Mac NZ

put the products – now branded as Nokia 
products – back in stores. Having the 
devices back in Apple’s retail ecosystem is 
probably a relief for the former Withings 
group, as Apple customers are the target 
market for the now-Nokia products.

New Zealand password app
Lookiimedia has just announced Mycena, 
a new password management app for iOS 
(and Android) devices.
Designed for non-technical users to make 
saving and retrieving passwords fast and 
painless, Mycena provides up to three 
levels of password security, free for the 
first five passwords. Additional password 
storage is available via small one-time 
payments rather than monthly or annual 
subscription fees.
Mycena can be used on multiple devices 
including a mix of iOS and Android, 
and passwords can be synchronised via 
Mycena’s cloud service. However, O’Toole 
says the company recommends that users 
delete the cloud copy of their passwords 
once synchronisation is complete. Pricing 
is free to cover 5 passwords, NZ$4.49 
for 20 passwords, NZ$7.49 for 50 and 
NZ$14.99 for 120  (all are one-off costs, 
and multi device). In US dollars this is 
roughly $3.29, $5.48 and $10.97. 
Check Mycena’s blog for more info.
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apple&talk > ‘Good’ enemies, and the Apple succession

When Apple was an underdog fighting 
the Wintel hegemony, Steve Jobs believed 
it was good to have an enemy. In Apple’s 
early days, Steve Jobs had IBM as the 
enemy, which seems odd now that the 
companies collaborate too much. Having 
an enemy keeps employees and fans alike 
focused on the company and the platform, 
which can be a dream scenario. Steve Jobs 
was expert at stoking those fires, and 
then reversing course and embracing the 
enemy as a long lost – and necessary – 
friend. There’s no tech company Apple is 
particularly disenchanted with now, so no 
obvious enemy – Apple has been working 
with Microsoft, for example, for years, 
and even when the incendiary Balmer 
was its CEO it never got really bad. Now 
collaboration is even better thanks to CEO 
Satya Narayana Nadella.

An obvious foe, you’d think, would 
be US President Donald Trump. He’s 
anti-gay, anti-foreigner, retrogressive, 
aggressive, big-mouthed and, most likely, 
mentally unbalanced (or at least mentally 
inadequate), yet even Apple isn’t game to 
take him on. Although honestly, I suspect 
Jobs may have been obstreperous enough. 
(Jobs’ father was a Syrian refugee, but Steve 
was born in the US and adopted out). Yet 
Tim Cook has worked with Trump’s advisory 

teams on occasion, despite abhorring 
Trump’s anti-gay stance and his anti-
immigrant bias and, I’m sure, quite a lot 
more. Apple has also pledged to guard its 
users privacy while Trump calls for tools to 
decrypt everything, or at least encrypt data 
less (all of which may complicate Apple’s 
push into Artificial Intelligence, which you 
have to admit looks more attractive in 
the light of where so-
called ‘human 
intelligence’ 
appears to be 
leading us these 
days).
While Tim 
Cook has made 
veiled references 
to Facebook 
and Google’s 
harvesting of data 
for profit, they’re, you know, veiled: 
“They’re gobbling up everything they can 
learn about you and trying to monetise it,” 
he said in a 2015 speech. “We think that’s 
wrong.” My italics – “They”being mostly 
Google and Facebook.

I’m not criticising Cook – I think 
Jobs made a great choice in him. And 
succession can be such a poison chalice. 
Just look how badly the New Zealand 

Labour Party has handled that over the last 
ten years, and where that’s led: National 
is floundering yet there’s no one able to 
capitalise on it. 
But who would succeed Cook, who has 
piloted Apple through stormy waters while 
continuing to make vast profits, while 
growing Apple’s services into a money-

making behemoth?
Tim Cook was already 
Chief Operating Officer 
and essentially running 
Apple during the 
illness of Steve Jobs 
in 2009-11, learning 
every aspect of the 
company while being 
groomed to take 
the helm. If the only 

candidates are Phil Schiller 
and Jeff Williams, they’re gifted and very 
competent, sure, but also both very ‘white 
bread’.

I believe Apple needs to keep promoting 
diversity within the company to stay 
successful in this divisive world. If 
either of these guys end up in charge, they 
need a strong, connected and diverse 
management team under them to keep 
engaging with world concerns – and world 
markets.
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apple&talk > Ten years of  iPhone!

Ten years 
of iPhone, 
crikey. 
Apple did 
not invent 
the smart-
phone, 
no. Apple 
made the smartphone usable, just like 
it did with the Mac as regards the PC 
industry back in 1984. Apple doesn’t need 
to invent new platforms, it just needs to 
keep making them meaningful to us. Before 
the Mac (even though Apple was dabbling 
in this territory with Apple computers 
that predated the Mac) you had to pretty 
much type instructions to send a page to a 
printer. 
If you wanted a bold header, you had to 
type in code that directed it to bold the 
header. You didn’t know if you got it right 
till the page printed. Apple put visual clues 
on the screen to help us get tasks done: 
folders looked like actual paper folders, 
files looked like paper documents etcetera. 
This seems obvious to everybody now, but 
back then, it was revolutionary.

It looks obvious now, because 
everybody copied it. That’s Apple’s true 
strength, in my opinion. If you truly love 
your smartphone by Samsung, HTC or 

whatever, and you think it’s far superior (or 
at least cheaper) than iPhone, well great 
– where would you be without Steve Jobs’ 
vision to make that first iPhone ten years 
ago?

There’s considerable pressure for Apple 
to do something spectacular this year 
because it’s the tenth anniversary of 
iPhone. I’ve been saying this too, but 
actually, I didn’t mean Apple might bring 
out something with a laser death ray, 
dancing virtual elephants, tooth-flossing 
and a cure for baldness, no. I just meant 
Apple would probably change the physical 
attributes of the phone, since the 6 and 
7 are basically in the same cases; the 10th 
anniversary model at least deserves a 
new case design, and perhaps even better 
screen tech (OLED seems a possibility).
When you think about it, a smartphone can 
only be designed so far – it needs a charge 
port, visible or not, some way of attaching 
earbuds (visible or not) and buttons for 
volume, sleep, mute, and it needs a large 

screen as most of the interface functions 
are via touch-screen … and it has to fit in 
your pocket. 
Apple’s been toying with cable-free tech 
(EarPods) but who knows how far this will 
get in this year’s model? I haven’t been 
posting what the new iPhone will have 
and look like, unlike even the NZ Herald, 
because this is all speculation and rumour 
and doesn’t deserve the attention it has 
been receiving. 
The big changes over the years have been 
the motion coprocessor, Touch ID and 
3D Touch. Apple has been playing with, 
and acquiring, all sorts of AI, AR and VR 
technologies, but Apple looks way ahead 
into the future. As you probably know, 
Steve Jobs conceived of the iPhone 25 years 
before it was possible to make it.

Will iPhone 8 be great? Yes, because the 
7 is, the 6 was, the 5 was … all the way 
back to 2007 when the first iPhone came 
out. Revolutionary, beautifully-built, life 
changing. What more could you ask for?
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> Weather anywhere, Reminders, Night Shift, Calendar and moretips&tricks
1/ Check the 
Weather anywhere 
using Spotlight — If 
you’re curious what 
the weather is like, 
you can launch the 

stock or a 3rd party weather app, sure, or 
just pull down on a Home Screen page to 
get Spotlight (device and ’net search) to 
appear. Type in “weather (and location)” 
to get the weather report for that spot. 
You’ll get the details you’re looking for. The 
same applies to any day within the normal 
seven-day forecast period. This Spotlight 
trick works on iPad, too. (It even works on 
macOS in Spotlight.)

2/ Delete all Reminders in a list — 
Sometimes, you want to quickly delete 
all reminders in a list. People use the 
Reminders app as a catch-all for everything 
we want to remember, whether it’s work-

related or a group of tasks we need to carry 
out.
Within iOS, there’s a way to delete not 
only the list, but also all the reminders 
within that list. This works for things you’ve 
marked as completed, along with tasks that 
you haven’t tapped to show them as done. 
Launch the Reminders app and navigate to 
the list you want to delete.
Now, tap the Edit button in the top right 
corner of the app.
Scroll to the bottom (if you can’t see it) and 
find the item that says Delete List.
Tap that option and confirm you want to 
delete all the reminders. 
(This is a viable on Mac too: secondary click 
(right- or Control-click) the name of the list 
and choose Delete. If you are working in 
iCloud.com, you can go to a Reminders list, 
click on Options, and then choose Delete. 
When you delete a Reminders list from 
one device, that action will take place on 

every device logged into the same iCloud 
account.

3/ Night Shift Mode into Staying on 
All the Time — You can have Night Shift 
on iOS on all the time if you prefer the 
softer lighting (it’s more yellowish) of 
Night Shift mode all the time. Night Shift 
is most useful after sunset, you may 

want to have it enabled all the time. This 
display-based setting makes your screen 
“warmer,” usually at night, to cut down on 
blue light exposure which is believed to 
keep people awake. To get to this setting: 
Settings> Display & Brightness> Night 
Shift. The default is to have the mode 
activate at sunset, and then deactivate at 
sunrise but you can also set custom start 
and stop times for the mode.
To keep Night Shift on during the day, you 
need to set custom hours for the feature. 
Unfortunately, you can’t set the start and 
stop times the same so you have to decide 
on a one-minute time of the day (or night) 
when it’s okay for the mode to briefly 
deactivate: for example, Night Shift could 
temporarily stop at 1:59am. Then, the mode 
turns back on at 2am.

4/ Set your default Calendar across 
devices — People can find their Mac set to 
add events by default to one calendar while 
their iPhone is adding them automatically 
to a different one. This can make it seem 
that iPhone events are colour-coded 
differently to Mac events, which is 
confusing.
All your Apple devices that can sync 
with your iCloud account have a “default 
calendar” setting that’ll be applied when 
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tips&tricks > iOS continued, plus a mix of  tips for macOS Sierra

you don’t specifically change which one you’d like to add an event 
to. On the iPhone and iPad, this option is listed under Settings > 
Calendar. On the Mac, this setting is within Calendar > Preferences 
under the “General” tab.

5/ Dealing with other calendar services — When a device is 
set to sync to a calendar (say, a Google one) and that particular 
calendar isn’t even configured on another of that person’s devices, 
it will make it seem like everything from one device is disappearing. 
You can check which accounts you’ve got set to sync calendars on 
the Mac under System Preferences > Internet Accounts.
Any of your accounts that have “Calendars” listed in grey 
underneath their names are syncing that service with your Mac. 
Verify that you’ve got the same list turned on for your iPhone or 
iPad at Settings > Calendar > Accounts.

Extra – The Health app: as Apple Insider puts it in a detailed 
explanation, the launchpad for all things health is the Health Data 
tab, which lists all of the categories the app can handle. While 
Activity, Mindfulness, Nutrition and Sleep are front-and-centre, 
others include Body Measurements,  Health Records, Reproductive 
Health, Results and Vitals. These all break down into numerous 
subcategories, where the real meat of the app is found. Under 
“Activity,” for instance, are items like steps, workout duration, and 
active energy consumption. Tapping on one displays a graph with 
adjustable views, as well as an explanation, suggested apps, and a 
set of configuration options.

Extra extra — the logic of iPhone/iPad Force Quitting: The Mac 
Observer has a detailed description of why and when you may need 
to do this – and when you shouldn’t worry.

1/ View ‘Live Photos’ in macOS Sierra’s Photos app — The Live 
Photos feature of recent iPhones is a lot of fun. It captures 1.5 
seconds of movement surrounding a 12-megapixel still image 
(think the “moving newspaper” photos in the Harry Potter films). 
A Live Photo is signified by a small concentric circle and “Live” 
text in the corner of the picture. If you want to play the video 
portion of a Live Photo in macOS Sierra, here’s how:
Open the Photos app, then open any album where a Live Photo is 
contained. Open any Live Photo by double-clicking on it.
Hover the mouse cursor over the Live Photo to play the video 
portion of the picture in Photos on Mac.

2/ Turn off Highlighting on Related Messages in Mail — You 
can turn this view off really easily by picking a mailbox from the 
sidebar and deselecting Organize by Conversation from the View 
menu.
That choice is set on a per-mailbox basis, though, so you’ll need to 
go through and do it for all of your mailboxes if you never want to 
see conversations again.
There is a related feature that drives 
me nuts, too. Depending on your 
settings, Mail may be highlighting all 
related messages with a colour when 
you click on just one of them, even if 
conversation view is off. Click on an 
email in grey, and then all of the other 
messages from that thread light up 
in blue. Maybe that’s handy for you, 
but if you find it visually confusing, 
you can disable this. Choose Mail > 
Preferences from the menus at the 
top, and then when the Preferences 
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tips&tricks > macOS Sierra continued (a mixture)

window appears, click on the Viewing 
tab. The option Highlight messages with 
colour when not grouped is what you turn 
off if you aren’t a fan of this feature. If you 
prefer, you could also click on that little 
coloured box next to Highlight messages 
with colour when not grouped to pick a 
different colour to use for the highlight. 
Then you make it really, really obvious why 
those messages are coloured.

3/ Which Mac apps are 32-Bit — Apple 
plans to stop support for 32-bit apps 
across iOS and macOS. While iOS 11 
will remove them this fall, macOS will 
continue to support them until 2019. 
Nevertheless, it doesn’t hurt to start early 
and find the 32-bit Mac apps. If you do 
find that software you rely on is 32-bit, 
contact the developer and see if they plan 
to update to 64-bit. Most developers 
will, but older software may not get this 
support, so you might have to start finding 
alternatives.
On your Mac’s desktop, click on the Apple 
logo () at the upper left of the screen.
Click About This Mac.
In the window that pops up, click System 
Report. In the System Information app 
that this brings up, find Applications under 
Software in the left menu.
Click on Applications, and your Mac will 

take a few seconds to compile the list.
Once it’s finished, scroll sideways to right 
until you see the header 64-bit (Intel).
Apps will have a Yes/No designation to 
determine whether they are 32-bit Mac 
apps or not. “Yes” means they’re 64-bit 
and “No” means they’re 32-bit.
Many of the items in the list will be from 
Apple; you don’t need to worry about 
those. Instead, look for the ones that say 
Identified Developer.

4/ Contacting Calendar invitees — 
There’s an easy way to send an email or 
a message to all of the participants to an 
event on a Calendar if you need to pass 
along new information without putting it 
on the invite. Just right- or Control-click 
on the event in question. The contextual 
menu  that appears contains all sorts of 
helpful options, like a way to switch up 
the calendar the event is on, for example. 
But our two choices are near the bottom: 
Email All Participants and Message All 
Participants. If you pick Email, your Mac 
starts composing one to all listed invitees 
with the details of the event already in the 
body of the email. You can then add in any 
information you need. 
In iOS, tap on the event, and then scroll 
down to find the Invitees section. Tap that, 
and you’ll see a small envelope icon you 

can use to email the participants – much 
faster than typing everyone’s email in. 
(From the Mac Observer.)

5/ Blank disk image for storage — Using 
the Disk Utility in macOS Sierra, you can 
create a blank disk image for storage. A 
disk image (.dmg file) is a file that looks 
and acts like a mountable device or 
volume like  hard drive or thumb/USB 
drive, but it’s not – it’s virtual. But you can 
fill an empty disk image with data, then 
use it to create disks, CDs, or DVDs or even 
unmount it, and mount it when you need 
it, so it’s generally hidden.
To create an empty disk image:
Choose File > New Image > Blank Image.
Enter a file name for the disk image, add 
tags if necessary, then choose where to 
save it. This is the name that appears in 
the Finder, where you save the disk image 
file before opening it.
In the Name field, enter the name for the 
disk image.
This is the name that appears on your 
desktop and in the Finder sidebar, after 
you open the disk image.
In the Size field, enter a size for the disk 
image.
Click the Format pop-up menu, then 
choose the format for the disk:
If the disk will be used with Mac 
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tips&tricks > Working smarter with iOS from Macs and on iPhone/iPad

1/ Check your 
iPhone battery 
percentage from 
your Mac in macOS 
Sierra — If you are 
an iOS user who 
also has a Mac, 
making sure your 
Mac and iPhone are 
both using the same 
iCloud account and 
you have Bluetooth 
enabled, you can hold down the Option 
key on your Mac’s keyboard and click the 
Wi-Fi icon in the Mac menu bar. 
After a second or so, your iPhone will show 
up in the Personal Hotspot section even 
if you’re not using it to set up a personal 
hotspot.
If you’re not using it as a personal hotspot, 
that option will be in light grey; if you 
are using the iPhone for that purpose, 
Personal Hotspot will be in bold letters. 
Either way, the battery icon and signal 
strength is displayed (left).
However, if you mouse over your iPhone’s 
line, a small menu will appear that shows 
the exact percentage of battery you have 
left (below).

computers, choose Mac OS Extended 
(Journaled) or Mac OS Extended (Case-
sensitive, Journaled). If the disk will be 
used with Windows or Mac computers 
and is 32 GB or less, choose MS-DOS (FAT). 
If the disk will be used with Windows or 
Mac computers and is over 32 GB, choose 
ExFAT.
To encrypt the disk image, click the 
Encryption pop-up menu, then choose an 
encryption option.Click the Partitions pop-
up menu, then choose a partition layout. 
Click the Image Format pop-up menu, 
then choose an option:
Sparse bundle: Same as a sparse image, but 
the directory data for the image is stored 
differently. Uses the .sparsebundle file 
extension.
Sparse: Creates an expandable file 
that shrinks and grows as needed. No 
additional space is used and it uses the 
.sparseimage file extension.
Read/write: Allows you to add files to the 
disk image after it’s created. Uses the .dmg 
file extension.
DVD/CD master: Changes the size of the 
image to 177 MB (CD 8 cm). Uses the .cdr 
file extension.
Click Save, then Done. Disk Utility creates 
the disk image file where you saved it in 
the Finder and mounts its disk icon on 
your desktop and in the Finder sidebar.

2/ Individual Read Receipts in Messages 
— You can turn on read receipts in 
Messages for just one contact. If you tap 
the information button (an “i” with a circle 
around it at top-right of your screen) you’ll 
see the option to enable read receipts just 
for that person.

3/ Take screen shots on iPhone and 
iPad — The ability to quickly snap a photo 
of whatever’s on your iPhone’s (or iPad’s) 
screen. It’s handy for documenting buggy 
iOS apps to quickly sharing a text message 
thread with a friend.
Just press the Sleep/Wake (on the top right 
of your iPhone/iPad) and the Home button 
(the dished button at bottom centre of 
your screen) at the same time. The screen 
will flash and you’ll hear a telltale camera 
snap, then find your screenshot sitting in 
the iOS Photos app’s Screenshots album or 
in your Camera Roll. From there, you can 
share it by tapping the Share Sheet button 
(the square button with the upward 
arrow).

4/ Pinch-and-zoom to enlarge stickers 
— You can actually adjust how large or 
small stickers are before you send them: 
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tips&tricks > iOS continued, and another Mac medley for macOS

when you’re peeling a sticker off to put it 
somewhere in your conversation, add a 
second finger and pinch-to-zoom to make 
it bigger or smaller before you use it.

5/ Unfreeze a frozen iPhone — It’s winter 
here in NZ but hey, this can happen in 
summer too. Sometimes your iPhone may 
come to a grinding halt, perhaps because 
of an errant app, or maybe iOS itself has 
locked itself up somehow. Generally 
speaking, quitting a frozen app (by double-
clicking the Home button, then swiping 
up on the app’s multitasking card that 
appears) is enough to fix the problem. You 
could also try a standard restart (press 
and hold the Sleep/Wake button until the 
“slide to power off” slider appears).
But if an app remains stubbornly stuck—or, 
worse still, if iOS becomes completely 
locked up—there’s another way to get 
things moving again: by force restarting 
your iPhone (aka, a “hard” reset).
On pre-iPhone 7 models: Press the Sleep/
Wake and Home buttons—but instead of 
letting them go immediately as you would 
when taking a screenshot, keep holding 
them until the screen goes blank. In a 
moment or so, you should see the Apple 
logo, a sure sign that your iPhone (or iPad) 
is rebooting itself.
On iPhone 7 or iPhone 7 Plus: Press and 

hold the Sleep/Wake and 
volume-down buttons 
until you see the Apple 
logo.

1/ Two ways to turn 
on Do Not Disturb on 
Mac — If you’re in the 
Notification Center (sic 
– and this is under the 
little 3-lines-3 dots icon 
top right of your Mac’s 
screen) the already, simply pull down the 
panel until you see Do Not Disturb. (If your 
Mac supports it, you can also enable Night 
Shift mode from there.)
Alternatively, Option-click (hold down the 
Option key on your keyboard and click) the 
Notification Center icon in the status bar, 
and Do Not Disturb will turn on.

2/ How to rule Launchpad — Do you use 
Launchpad, the iPad-like app launching 
interface on Mac? I have to admit I don’t. 
But if you do, why not set it up how you 
want to? You can delete apps from your 
Applications folder using Launchpad, just 
like you can from the Home Screen on iOS. 
Simply bring up the Launchpad app, and 
press the Option key until the apps start 
wiggling. 
You’ll see X symbols in the apps you can 

delete, so go ahead and clean up your 
Applications folder. 
(Technically, you should be using an app 
cleaner, which deletes files elsewhere that 
are connected to apps in the Applications 
folder as well, but for little apps, this can 
be fine.)
Also note this is most unlike the Dock, 
since deleting an app from the Dock leaves 
that app safe in Applications – it just 
removes the quick link  button to the app 
that the Dock generates for you.

3/ Filter Unread Messages in macOS 
Mail — The Mail app now allows you to 
filter your unread messages. At the top 
of the messages pane, you’ll see a circle 
with an upside-down triangle. Just click on 
that little button, and Mail will filter your 
email, showing you only unread messages.
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tips&tricks > macOS tips continued – launching and lyrics

4/ Quick Look at Documents and Images 
— The Finder has a Quick Look feature. 
After you’ve single-clicked on a document, 
image, or other types of files, press the 
space bar on your keyboard. A quick 
preview of that file will show up, along 
with the option to open it in the correct 
app. 
Remember, a single-click selects, a 
double-click launches – the confusion here 
is buttons, like items in the Dock,which 
launch with a single click.
To select items on the Desktop, you can 
also click-and-hold beside them and drag 
over to select ore than one things at once. 
Then you can tap the Space Bar and cycle 
through all of them, whether they be 
images, documents, PDFs or even movies 
or sound files. 
(There’s one more important attribute 
of buttons in the Dock, by the way – 
click-and-hold, which displays new and 
different functions in a pop-out menu.)

5/ Quickly get lyrics to songs in Apple 
Music — If you’re an Apple Music 
subscriber and use iTunes on your Mac, 
you’ll be pleased to know you can access 
song lyrics without ever leaving the app. 
Click the Up Next button to the right of 
the status window, and you’ll see a tab for 
lyrics. Click it …

Here’s a slightly-related extra tip, in the 
silly fun department: launch Siri, and say 
to it ‘I see a litle silhouetto of  a man ...’ 
and wait a couple of  seconds. 
(Yes, that’s ‘silhouetto’, not ‘silhouette’)
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> How to use the MacNZ site (www.mac-nz.com)

This is a free service – I run Mac NZ to help people to stay informed. The few ads just pay for Mac NZ’s web hosting.

Mac NZ reaches up to 6000-10,000 a month people via 

emails, tweets, Facebook, LinkedIn and direct clicks

Make this your Home Page: go to Mac NZ in Safari, open Preferences from the Safari menu, click the 
General tab & click ‘Set to Current Page’ to get instant Apple news whenever you launch your browser
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